Montgomery County Swim League

2011 Automation Handbook
AUTOMATION COMMITTEE AND CLINIC INFORMATION

Automation Committee Members automation@mcsl.org

<table>
<thead>
<tr>
<th>Member Name</th>
<th>Address 1</th>
<th>Address 2</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mike Lincoln (G)</td>
<td>9831 Hollow Glen Pl.</td>
<td>Silver Spring, MD 20910</td>
<td>301-588-8424</td>
</tr>
<tr>
<td>Bob Hincke (LM)</td>
<td>8505 Silverfield Circle</td>
<td>Montgomery Village, MD 20886</td>
<td>301-948-6540</td>
</tr>
<tr>
<td>Linda Raab (TW)</td>
<td>6606 Old Stage Road</td>
<td>Rockville, MD 20852-4328</td>
<td>301-984-8812</td>
</tr>
</tbody>
</table>

2011 Automation Clinic Information

<table>
<thead>
<tr>
<th>Date</th>
<th>Day</th>
<th>Time</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 1</td>
<td>Wednesday</td>
<td>7:00-9:00 pm</td>
<td>Martin Luther King, Jr. Swim Center 1201 Jackson Road, Silver Spring</td>
</tr>
<tr>
<td>June 8</td>
<td>Wednesday</td>
<td>7:00-9:00 pm</td>
<td>Montgomery Aquatic Center 5900 Executive Boulevard, Rockville</td>
</tr>
</tbody>
</table>

Before the Clinic
1. Make sure that Meet Manager 2.0 is installed on the computer that you'll use at the clinic. You will not need Team Manager for the clinic, but you might want to locate your copy of the application.
2. Download Maintenance Updates for each program from the Hy-tek website. See Sections 1-2 and 2.2.
3. Make a folder on the "C" drive of the computer you'll bring to the clinic called "2011AutomationTraining."
4. Download 2011 Automation Training Files (2011MCSLAutomationTraining.zip) from the MCSL website into the 2011AutomationTraining folder you created in Step 3. This zipped file includes:
   - a Meet Manager database for a dual meet that the Omega Team will swim against the Delta Team (2011ClinicMeet.mdb),
   - a roster file (O-PV-Roster001.ZIP), and
   - an entries file (O-PV-Entries001.ZIP).
5. Unzip the 3 files from 2011MCSLAutomationTraining.zip, and store them in the 2011AutomationTraining folder. Do not unzip the roster file (O-PV-Roster001.ZIP) or the entries file (O-PV-Entries001.ZIP).

What to Bring
1. Laptop computer; Power cord; Power strip.
2. If you can't bring a computer to the clinic, that's OK, come anyway.

Come Early
Given traffic and personal schedules, this is sometimes impossible. The meeting rooms will be available at 6:30 for both clinics so that everyone can have computers set up by 7:00.

Clinic Format
Our goal is to provide hands on experience. The clinic will focus on getting ready for and running a meet.
1. Set up a home meet using Meet Manager. Chapter 4, pages 19-30.
2. Run home meet with Meet Manager. Chapter 5, pages 31-42.

As always, we are happy to answer questions.
## CONTENTS

### Chapter 1. Team Manager Organization
- 1-1. Install Team Manager Program .............................................. 5
- 1-2. Download Team Manager Maintenance Update .......................... 5
- 1-3. Set-Up 2011 Database .......................................................... 6
- 1-4. Load 2011 MCSL Meet Event Files ........................................ 9
- 1-5. Designate Meet Types ......................................................... 10

### Chapter 2. Meet Manager Organization
- 2-1. Install Meet Manager 2.0 Program ........................................ 11
- 2-2. Download Meet Manager Maintenance Update ...................... 11
- 2-3. Download 2011 MCSL Templates for Meet Manager ............ 11
- 2-4. Check Equipment .............................................................. 12

### Chapter 3. Meet Entries
- 3-1. Prepare Meet Entries with Team Manager ............................. 13
- 3-2. Print Meet Entry Paperwork ................................................. 15
- 3-3. Export Entries and Athletes ................................................. 16
- 3-4. Exchange Entries .............................................................. 17

### Chapter 4. Home Meet Set-Up
- 4-1. Set-Up Meet ................................................................. 19
- 4-2. Enter Teams & Swimmers .................................................. 22
- 4-3. Seed Meet ............................................................... 27
- 4-4. Print Meet Program ....................................................... 28
- 4-5. Print Lane/Timer Sheets ............................................... 29
- 4-6. Pack Your Bags ............................................................ 30

### Chapter 5. Running a Home Meet
- 5-1. After the Scratch Meeting .................................................. 31
- 5-2. Enter Times ................................................................. 33
- 5-3. Score Event, Print Results ............................................. 34
- 5-4. Print Award Labels ....................................................... 35
- 5-5. Relays ................................................................. 36
- 5-6. Wrap-Up ............................................................... 37

### Chapter 6. Time Trials Using Team Manager
- 6-1. Create Time Trial Meet ..................................................... 43
- 6-2. Copy Events ............................................................... 43
- 6-3. Entering, Editing, and Deleting Times ............................... 44
- 6-4. Print Results ............................................................... 46

### Chapter 7. Automating “B” Meets
- 7-1. Team Manager Preparation ............................................. 47
- 7-2. Meet Manager Preparation ............................................... 48
- 7-3. Run the Meet ............................................................... 50
- 7-4. Automation Tips for Deck-Seed “B” Meets .......................... 51

### Chapter 8. Relay Carnival
- 8-1. Team Responsibilities .................................................... 53
- 8-2. Host Responsibilities .................................................... 53
- 8-3. Automation Recommendations ....................................... 55

### Chapter 9. Bells & Whistles
- 9-1. Team Manager ............................................................ 57
- 9-2. Meet Manager ............................................................ 62
**UNDERSTANDING TEAM MANAGER/TEAM UNIFY AND MEET MANAGER**

Meet Manager and EITHER Team Manager (TM) OR Team Unify (TU) are both necessary for team operations.

Team Manager and Team Unify store and organize all athlete information and the results of each meet. MCSL has no preference for Team Manager or Team Unify. If your team computer is running Windows XP, you may use Team Manager 4.0, 5.0, or 6.0. Computers with Vista or Windows 7 can run either Team Manager 5.0 or Team Manager 6.0, but not Team Manager 4.0.

Meet Manager runs only a single meet so you must have a Meet Manager database for each meet of the season. Every team must use Hy-tek’s Meet Manager 2.0.

Information is moved between Team Manager/Team Unify and Meet Manager by a process of exporting and importing (or downloading and uploading) as shown in the graphic below developed by Janice Flamand from Hallowell.
Chapter 1. **TEAM MANAGER ORGANIZATION**

1-1. **Install Team Manager Program**

Skip this step if Team Manager is already installed on your computer or you are a Team Unify customer.

1-1a. **Load Program**

Insert Team Manager applications CD into Drive.

If Windows AutoRun is turned on, Windows will automatically read the CD and begin the installation process.

If the installation process does not start…

From your Windows desktop, click on Start and then Run and key in the CD drive letter and then "setup". For example if your CD is Disk Drive D, enter D: Setup.

Hy-Tek’s Team Manager Installation software will guide you through the installation process. When asked for a directory/folder, Hy-Tek recommends accepting the default installation folder/directory "Hy-Sport\SwimTM6".

**DO NOT REMOVE THE CD.**

After the Installation process finishes, you may need to restart Windows.

1-1b. **Read License File**

After Windows has restarted, re-insert the CD (if you have removed it) and cancel if it starts to install again.

Click on the Team Manager icon on your Windows desktop. Team Manager will read the License file from the CD. Once this is completed, the Main Menu will be displayed.

File ➔ Open ➔ New, type in a database name or load a database already on your hard drive, and click Open.

Remove the CD; you will not need it again unless you need to re-install.

1-1c. **Copy and Store Applications CD**

You might want to give the original CD to the Team Rep and make a back-up copy for yourself.

1-2. **Download Team Manager Maintenance Update**

Skip this step if:

1. you are a Team Unify customer.
2. using Team Manager 4.0. Hy-tek no longer has a link to an update file on its website.
3. using Team Manager 5.0 and the box in the bottom left corner of the main menu screen says “Release 5.0jb.”

If using Team Manager 6.0 or do not have TM 5.0 Release 5.0jb, check for updates using one of the following methods.

Method 1. **From Team Manager**

Connect to Internet.

Start Team Manager.

“Check for Updates” from the Main Menu. Follow instructions.

Method 2. **From Hy-Tek’s Website**

Go to the Hy-teek Website [http://www.hy-tekltd.com](http://www.hy-tekltd.com).

“Support,” “Download Center” at the top of the screen.

Select the Team Manager product you wish to update.

Save downloaded file where you can retrieve it easily.

Open Team Manager if not already running, or go to Main Menu.

File, “Install Update” from the Main Menu. Follow instructions.

Once you have installed the Team Manager 5.0 update, you do not need to check further since Hy-tek is no longer supporting this product.

Check periodically for updates of Team Manager 6.0.

**TEAM UNIFY USERS SHOULD CONTACT TEAM UNIFY FOR ASSISTANCE IN COMPLETING THE STEPS IN THE REMAINDER OF CHAPTER 1 AND ALL OTHER TEAM UNIFY ISSUES.**

**E-MAIL:** SUPPORT@TEAMUNIFY.COM

**PHONE:** 541-359-2635
1-3. Set-Up 2011 Database

1-3a. Open 2010 Database

- File → Open → New.
- Highlight 2010 Team Manager database.
- File Name
- OR
- Open

You’ll be taken back to Main Menu. The path to and name of the database that you just opened will be displayed at the top of the screen.

1-3b. Back-up 2010 Database

- File → Backup.
- Browse to the drive and folder where you want to store the backup.
- OK.

- Yes to confirm.

- OK when you see “Backup Completed Successfully…” to return to Main Menu.

**Tip** You can set default directories for imports, exports, and back-ups from the Main Menu.

- Set-up → Preferences → Directory Preferences to reach the “Favorite Directories” screen.
1-3c. Create 2011 Database

You will use the 2010 database to create a Team Manager file for 2011.

- File → Open/New from Main Menu. Name the 2011 database.
- Open.

The new database will appear in the top bar and the “System Preferences” menu will appear.
- Cancel and ignore the pop-up message.

In the next step, you will restore your 2010 database into the 2011 database you just created.

1-3d. Load 2010 Data to Create 2011 Season Start

- File → Restore from the Main Menu.
- Highlight the 2010 backup file you created in 1-3b. OR
- Open

“Replace currently opened database” in the “Restore” screen.
- OK.
- OK to confirm that you want to replace the new file with the 2010 database.

OK to acknowledge that the restore is complete.

When the restore is completed the information from your 2010 database will be in the 2011 database. Now you will do edits and deletions to make the database ready to use for the 2011 season.
1-3e. Check System Preferences

- File→Set-up→Preferences→System Preferences.
- Check “Team/Swimmer Defaults.” Change if necessary.
- Change “Meet Age-up Date” to June 1 of current year.
- Change “System Age-Up Date” to June 1 of current year.
- Yes when this box appears.
- OK to close System Preferences.
- X in top-right corner to return to the Main Menu.

1-3f. Check Team Information

- Teams from the Main Menu OR X to highlight Team Name.
- Check that Team Code and Name match abbreviation and name shown in MCSL Handbook. Recommend editing or adding coach contact information.
- OK to close Team Edit, then X to return to the Main Menu.

1-3g. Delete 19-Year Olds

- “Athletes” from the Main Menu.
- “Age” column to sort by age. One click places the 19-year olds at the bottom of the list. A second click sends them to the top.
- Highlight Athlete to be deleted.
- X located left of the little stopwatch.
- “Yes” or “No.”
- You can delete only one athlete at a time.
- X to return to the Main Menu.

1-3h. Delete 2010 Meets

- “Meets” from the Main Menu.
- Highlight Meet to be deleted; Clinic 3 in this example.
- X located to the right of the
- “Yes” or “No.”
- You can delete only one meet at a time.
- X to return to the Main Menu.
1-4. Load 2011 MCSL Meet Event Files

1-4a. Download Files from MCSL Website
Download “2011MeetEventFilesforTeamManager.zip” from MCSL website and unzip it to a folder on your hard drive.

1-4b. Import Files to Team Manager

- File → Import → Meet Events from the Main Menu.
- Browse to location where you stored these files.
- The meet you want to import plus Open, OR
- OK when you see a box displaying the message below.

Highlight the file in the “Import Events” screen
- OK → Open OR → on the file name. It will have an .ev3 extension.
- OK in the bottom-right corner of the “Import Events” box.

- OK when you see the box displayed below.

Repeat for each meet. To see a list of the meets you have imported, click Meets from the Main Menu. In this example, all 2011 meets have been imported.
1-5. Designate Meet Types

This will prevent you from inadvertently using “B” Meet or Time Trial times for Divisional entries.

1-5a. Create Meet Codes

- Set-up \( \rightarrow \) Groups/Sub Groups/Codes from Main Menu.

- “Meet Type” in the top-right.

- Add to access the “Code Maintenance” screen.

- Complete the “Code Maintenance” box as follows.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Code Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Meet</td>
<td>A</td>
</tr>
</tbody>
</table>

- OK to return to the Groups/Sub Groups/Codes menu.

Create a code for “B” meets substituting “B” for “A.” Use TT for time trials.

1-5b. Assign “Type” and Since Date

- Meets from the Main Menu.

  - on the meet name, OR
  - Edit to open the “Meet Maintenance” screen.

  - “A Meet” in the “Meet Type” pull down menu.

  - “Use Since Date” box.

  - Type June 1 of current year using 2-digit numbers to right of “Use Times Since:” or use the little calendar to set the June 1 date.

  - OK.

  - Cancel to return to the “Meets” screen.

  Repeat for each meet in your database.

  - to close and return to previous menu.

1-5c. Restrict Divisional Entries

Make Divisionals an “A” meet as shown in 1-6c.

- “Restrict Entry Best Times to same Meet Type.”

- OK to return to the “Meets” screen.

We recommend that you maintain a single Team Manager database. Use “Groups” to divide your swimmers into categories, such as Pre-Team. Use “Meet Type” to classify your meets.
Chapter 2. Meet Manager Organization

2-1. Install Meet Manager 2.0 Program
Skip this step if program is already installed on your computer.

- Load Meet Manager according to instructions.
- OK to return to the Main Menu.
- Remove Applications CD.

Default File Locations
- The Meet Manager program is in c:\hy-sport\Sw-MM2.
- A folder called c:\swmeets is created on your hard drive. You can store your databases here or create your own folder.

2-2. Download Meet Manager Maintenance Update
Skip this step if the box in the bottom left corner of the main menu page says “Release 2.0Hm.”

Method 1. From Meet Manager.
- Connect to Internet
- Start Meet Manager.
- “Check for Updates” from the Main Menu. Follow instructions.

Method 2. From Hy-Tek’s Website
- “Support,” “Download Center” at the top of the screen.
- Select the MM 2.0Hm.
- Update.
- Save downloaded file where you can retrieve it easily.
- Open Meet Manager if not already running, or go to Main Menu.
- “File,” “Install Update” from the Main Menu. Follow instructions. Once you have installed this update, you do not need to check further since Hy-tek is no longer supporting this product.

2-3. Download 2011 MCSL Templates for Meet Manager

<table>
<thead>
<tr>
<th>Download</th>
<th>Name</th>
<th>Size</th>
<th>Date Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unzip</td>
<td>DivRelay2011.mdb</td>
<td>1,856 KB</td>
<td>3/16/2011 1:08 PM</td>
</tr>
<tr>
<td></td>
<td>DivRelay2011_5Team.mdb</td>
<td>1,856 KB</td>
<td>3/16/2011 1:09 PM</td>
</tr>
<tr>
<td></td>
<td>Week-1A-2011.mdb</td>
<td>2,032 KB</td>
<td>3/16/2011 12:52 PM</td>
</tr>
<tr>
<td></td>
<td>Week-3A-2011.mdb</td>
<td>312 KB</td>
<td>3/16/2011 1:00 PM</td>
</tr>
<tr>
<td></td>
<td>Week-4A-2011.mdb</td>
<td>312 KB</td>
<td>3/16/2011 1:24 PM</td>
</tr>
<tr>
<td></td>
<td>Week-5A-2011.mdb</td>
<td>312 KB</td>
<td>3/16/2011 1:01 PM</td>
</tr>
</tbody>
</table>

Now, you are ready for your home meets. Although you have databases for every dual meet, relay carnival, and Divisionals, you will use databases only for the weeks that your team swims at home (or if you are hosting Relay Carnival or Divisionals).

Note: The file called “DivRelay2011_5Team.mdb” is for Division O.
2-4. **Check Equipment**

We recommend that you test your automation equipment well before the season begins especially if you will be using equipment that has not been operated since the previous summer. This section lists a few things to think about.

2-4a. **Computer**

We recommend that you set up the computer together with printer(s), mice, and keyboards before your first meet. Print a report to test.

2-4b. **Computer Accessories**

- A CD or DVD reader is needed to load Team Manager and Meet Manager.
- Since most new laptop computers do not have floppy drives so you will need a flash drive or a CD to import and export meet files.
- Mouse and keypad often make it easier.

2-4c. **Printer Issues**

2-4.c1 **Connections**

Many new laptop computers provide only USB connections to printers, mice, and keyboards while some older laptops have only serial, parallel, or P/S2 ports. You need to be aware of the connections you’ll need for printers, mice, and keyboards.

2-4.c2 **Drivers**

Drivers must be installed for each printer that you will use. Most drivers and installation instructions can be downloaded from manufacturers’ websites.
Chapter 3. MEET ENTRIES

3-1. Prepare Meet Entries with Team Manager

3-1a. Individual Swimmer Entries

To enter an athlete in an event,
- check box to the right of the swimmer’s name in the “Entr’d” column. The row with the swimmer’s name will be highlighted in yellow. You may be asked to select a team.

To delete an athlete,
Uncheck the box to the right of the swimmer’s name in the “Entr’d” column. The yellow highlighting will disappear.

To create a custom time,
- check box to the right of the swimmer’s name in the “Entr’d” column. Type a time in the “Custom” column. That time is used only to seed the swimmer in a particular meet and does not become part of his/her records. When entering more than one swimmer without times or with identical times, create custom times that will seed them as the coach wishes. Since Meet Manager seeds swimmers without, or with identical, times randomly, subsequent reseeding may assign different lanes.

To enter swim-ups,
- “Show Swim-Up Athletes.” The check box to the right of the swimmer’s name in the “Entr’d” column. Type a custom time, if needed.
EXAMPLE

- Donald Duck and Dish Towel are the only 15-18 boys available for the upcoming meet.
- Donald Duck has the fastest time in this event. He will be Omega Team’s top seed—the “A” swimmer.
- To see who else might be entered in the event, the coach clicked “Show Swim-Up Athletes” and kept the swimmers sorted by time. The phenom Raleigh Durham was chosen to “swim up.” Although this is an awesome opportunity for the 5-year old, it makes him ineligible to swim his age-group events, but he could swim other 15-18 events.
- The coach wants Dish Towel to be Omega Team’s 2nd seed—the “B” swimmer even though his time is slower than Donald Duck or Raleigh Durham. He is entered with a time faster than Donald’s time, but slower than Raleigh Durham’s time (i.e. a custom time) by typing the desired time in the “Custom” column.

### 3-1b. Relay Team Entries

- Your team in the “Swim for Team” pull-down menu towards the top center of the screen
- New Relay. An “A” Relay entry will be created. You’ll probably need to enter a custom time for the “A” relay in your first “A” Meet as shown below.
- New Relay again to create a “B” relay entry. You do not need an entry time.

If swimmers’ names appear in the box under “Swimmers,” click “Clear Swimmers.” Team Manager will confirm that you want to remove each swimmer from the relay. We generally recommend that you prepare relay entries without swimmers.

- Close to return to the Main Menu.
3-2. Print Meet Entry Paperwork

3-2.a1 Rosters

Complete "Report Filters" as shown.

TIP To ensure that swimmers’ entry times are based on times swum in the current season, check “Include Proof of Time” Under “other Options.” The report will show the meet where the entry time was achieved. This is especially helpful for Divisionals where entry times must have been swum in an “A” meet.

✓ Verify that that entries are correct.
✓ Make sure that no one is swimming 4 events unless one is an Individual Medley (IM).
✓ If possible, have the coach double-check before you print more copies and make the entry and roster files. Print enough copies for each team.
3-3. Export Entries and Athletes

Insert Storage device in the appropriate port.

File from the Main Menu. Select Export

Choose “Meet Entries” or “Athletes/Teams.” You cannot export Meet Entries and Athletes/Teams at the same time.

Select Drive and Folder where you want to store the files. In the example, the file is being exported to a flash drive.

Select Meet (or Team) you want to export from the pull down menu.

OK. When the export is finished, the small rectangle appears.

OK to close the small rectangle.

Close to return to the Main Menu.

The graphics below show the export operations for entries and rosters.

MAKE A NEW ROSTER FILE BEFORE EACH MEET TO ENSURE THAT A CURRENT ROSTER IS SUBMITTED FOR EACH MEET. THIS WILL ENSURE THAT ATHLETES, WHO REGISTER AFTER THE SEASON BEGINS, ARE INCLUDED. DO NOT SEND THE ROSTER FILE CREATED FOR WEEK 1 TO EACH SUBSEQUENT MEET.
3-4. Exchange Entries

3-4a. In-Person Exchange

3-4.a1 Home Team

The home team needs to give the following items to the visiting team.

☑ At least 1 paper copy of the Meet Entries
☑ At least 1 paper copy of the Team Roster

 Remind your coach to let you know which teams have chosen odd and even lanes.
 Make copies of the entries and roster for your Rep(s), coaches including a copy for yourself.
 Once you have given the meet entries and roster papers to the coach, DO NOT make any changes to the meet without involving your Rep until after the scratch meeting.

3-4.a2 Visiting Team

The visiting team needs to give the following items to the home team.

☑ At least 1 paper copy of the Meet Entries
☑ At least 1 paper copy of the Team Roster
☑ CD or flash drive with the Meet Entry and Athletes (Team Roster) files
☑ Make copies of the entries and roster for your Rep(s), coaches including a copy for yourself.

3-4b. E-Mail Exchange

MCSL Rule 11.j.ii.2. E-mail exchange.

a. Teams may exchange meet entries and team rosters by e-mail if both team representatives agree.

b. If teams choose to use e-mail, the e-mailed meet entries and roster become the official entries for the meet. A team cannot change its entries after the e-mail exchange or before the scratch meeting without the consent of both team representatives.

c. By agreeing to e-mail exchange, a team waives its right to protest any issues arising from the e-mail exchange.

How to Create Printable, Electronic Copies of Meet Entries and Roster List

When teams agree to e-mail exchange, each team should consider providing an electronic, printable copy of the entries and roster to the other. An easy, and cost-free, way to do this is to create a document using Cute PDF.

 Log on to the Cute PDF website at http://www.cutepdf.com/.
 Download the free version of Cute PDF Writer and install as instructed. After installation, “CutePDF Writer” should be on your list of “Printers and Faxes.”
 Create an entries report as shown in 3-2.a1 or a roster report as shown in 3-2.a1. If you check the option “Include Proof of Time” when creating an entries report, the report displays the name and date of the meet where the entry time was achieved—handy for Divisionals where entry time must have been achieved in an “A” meet. Custom entry times are indicated as such.
 Instead of printing the resulting report, click “Print Setup” (the icon that has a yellow belt around the printer), select “CutePDF Writer,” click OK.
Click the printer icon. CutePDF should be the chosen Printer as shown below.

When you click OK, you will be asked where you want to save your report. In this example, an entries report is being saved to the desktop. You can give it a different name. In this example, the report is named “Week1_OmegaEntries.

Repeat process to create a roster report.

Attach each file to an e-mail along with the entry and roster files you created in 3-3.

**Note About Creating Printable, Electronic Copies Using Microsoft Word**

If you are using Microsoft Office 2007, you may not be able to easily create printable, electronic copies of Meet Manager reports in MS Word.
Chapter 4. HOME MEET SET-UP

4-1. Set-Up Meet

4-1a. Load Meet

- File → Open/New from the Main Menu.
- Highlight the meet you are hosting.
- OR
- Open.

Week-1A-2011
You will return to the Main Menu, and the name of the newly-opened database will appear at the top of the screen. It contains MCSL records, events, all star times, scoring parameters, etc.

PLEASE DO NOT CHANGE ANYTHING IN THE MEET SET-UP MENU.

4-1b. Format Report Preferences

- “Report Preferences” from the Main Menu to reach the “Report Preferences” screen.
- Each of the 4 tabs to change settings

The Report Formats shown here are the settings in the MCSL templates. You can change them.

Use the Printer Set-Up to tell Meet Manager the name(s) of the printers that you will use to print reports (programs, lane/timer sheets, results). In this example, reports and labels are being printed on different printers. If you are using one printer for both reports and labels, select the same printer for both operations.
4-1c. Format Award Labels

Select Awards from the Main Menu.

Select Award Labels.

Make changes to the Label Selection if needed. The template assumes sheets containing 30 labels.

Select "Participation" to generate an award label for each athlete who swims in the meet. This feature enables swimmers who are disqualified to receive a participation ribbon. This option generates both standard award labels AND the participation labels in a single step. Disqualified swimmers are given "NT" on their labels—Not "DQ."

If you decide to use this, change "Individual" and "Relay" places as needed.
4-1d. Format Run Screen Reports

Meet Manager 2.0 provides many options for formatting reports from the Run screen. In the MCSL templates, most of these settings are checked. These can be changed depending on your team’s preferences. For example, some teams agree that the scores might not be printed at the bottom of each result page.

Since MCSL meets do not use automatic timing equipment, no settings are established for “Backup Times.” “Report Preferences” were discussed in previous section. “Web Real-Time” requires an internet connection on-deck.
Format Results Reports

- Reports from either the Main Menu OR the Run Screen. *No need to set Preferences again.*

- "Columns/Format" tab at the bottom of the screen. If you want the report to print in a larger font, select "Single" or, for a smaller font—and less paper—select "Triple."

4-2. Enter Teams & Swimmers

4-2a. Import Rosters

- File→Import from the Main Menu.
- Select Rosters Only.

Browse to CD, flash drive, or place where you stored an e-mailed file. In this example, the roster file is on a flash drive.

- "view" button in top right corner. Click "Details" to show when each file was last modified. Click "Date Modified" to sort files in date order. Check date to make sure you have selected your most-recent roster file.

Highlight Zipped Roster file.
- OR
- Open at the bottom of the screen.
This screen tells you that the roster file has been unzipped. The next screen will display the unzipped file.

Select the .hy3 file. Unzipped roster and entry files are named Hfilexxx.hy3.

Open.

You’ll be asked to confirm many times that you are importing the correct roster.

OK or Done to return to the Main Menu.

4-2b. Import Entries

File ➔ Import from Main Menu

Select Entries.

Browse to CD, flash drive, or place where you stored an e-mailed file. In this example, the entries file is on a flash drive.

Follow the same procedure that you used for rosters. Click “Details” and sort the files by date.

Repeat process for the other team’s entries.

Tip: You can rename the entry files as long as you do not change “.cl2” to the right of the period.
4-2c. Make Corrections
This section shows how to incorporate handwritten corrections made to lineups after meet entry files were made.

4-2.c1 Individual Events

Athletes from the Main Menu or the Run screen to reach the “Athletes Screen.” The top part of the screen lists all athletes on each team’s roster. When you highlight a swimmer’s name, the events, in which the athlete is eligible to swim, are listed in the bottom half of the screen. The events in which he/she is entered, are highlighted and checked. The bar separating the athlete’s list from the entries can be sized.

TO SCRATCH A SWIMMER FROM ALL EVENTS (WHOLE-MEET SCRATCHES)
Highlight Swimmer whom you want to delete.

“Scratch All” at the top of the screen.

A pop-up will ask you to confirm whether you want to remove the athlete.

TO SCRATCH A SWIMMER FROM SOME, BUT NOT ALL, EVENTS
Highlight Swimmer for whom you want to make the changes.

“Scr” box in the event from which you want to scratch the swimmer at the bottom half of the screen.

A pop-up will ask you to confirm whether you want to remove the athlete.

TO ADD A SWIMMER INTO AN EVENT
Highlight Swimmer whom you want to add into the meet.

If the swimmer is “Swimming Up,” click “Show Swim-ups” at the top of the screen. The bottom half of the screen will add swim-up events to the list of age-eligible events.

Highlight Event into which you want to add the swimmer at the bottom half of the screen.

Type Entry Time or “NT.”
TO CHANGE NAME, TEAM, AGE, OR BIRTHDATE FOR A SWIMMER ALREADY IN THE MEET

Since MCSL rules require that each team supply a roster file, it is highly unlikely that you will need to change any information about a swimmer. It is even more unlikely that you will need to add a new swimmer into the meet.

Before the first “A” meet, review the information in Team Manager. Here are the things to focus on.

- Swimmers’ names spelled correctly
- Birthdates
- Team initials same as in MCSL Handbook
- LSC code set to “PV”.

Please do not change any information about a swimmer at the meet. If you discover a serious error, such as an incorrect birthdate, work with your Division Automation Coordinator so that the correct information is entered into the Division’s and the League’s databases. Also make sure that your own Team Manager database is adjusted.

We know that there are exceptions to every rule so we have included instructions for name and information changes.

1. Athletes from Main Menu.
2. Highlight Swimmer for whom you want to make changes.
3. Edit Swimmer and make change.

TO ENTER AN ATHLETE NOT ON THE MEET ROSTER

1. Add Athletes.
2. Fill in Last Name, First Name, Middle Initial (MI), Birth Date, Sex. If you do not have the birthday, enter an age that will place the swimmer in his/her correct age group.
3. Team from the list on the right-hand side of the screen. Leave Status at “normal.”
4. Write Athlete’s name on roster.
5. OK then cancel to return to the “Athletes” screen.

TO RETURN TO PREVIOUS SCREEN

- in top-right corner.
4-2.c2 Relay Events

Sometimes, relays are not included in entry files even though the automation person made the entry properly. In this example, only one Delta Force relay was entered without a time into Event 49. This section shows you how to enter a relay into the event and give the "A" relay a time to ensure correct seeding.

1. “Relays” from the Main Menu to reach the “Relays” screen.
2. In the bottom-right on the name of the team that you want to add to the event, in this case Delta Force.
3. OK on the “Relay Designator” to add a “B” Relay for Delta Force in Event 49.

After Clicking OK, a “B” Relay for Delta Force is included in Event 49.

Highlight Delta Force “A” Relay.
Type a time for the “A” Relay to make sure that it is seeded ahead of the “B” relay.

TO RETURN TO PREVIOUS SCREEN

 '#' in top-right corner.
4-3. Seed Meet

4-3a. Designate Odd and Even Lanes

- Set-up→Seeding Preferences from the Main Menu.
- Dual Meets tab to reach its Seeding Preferences” screen. The “Lane Assignments” side will be blank.

In this example, Delta Team chose odd lanes, and Omega Team chose even lanes. The “Seeding Preferences” graphic below illustrates how the teams were placed into their correct lanes.

4-3b. Perform Seeding Operation

- Seeding from Main Menu.
- Select All. Every event in the meet is highlighted in yellow.
- Start Seeding. A message noting the progress of the seeding will appear in the bottom of the screen.
- Reports to print Meet Program and Lane Timer Sheets, OR to close and return to Main Menu.

After the events are seeded, the screen will look like this.
4-4. Print Meet Program

- Reports from the Main Menu or from the Seeding Screen.
- Meet Program.
- Select All to print heat sheets for all the events on the list. The events will be highlighted in yellow.

- “Columns/Format” tab at the bottom of the screen.
- Features you want the printout to include.
  This example shows recommended selections

- “Include in Meet Program” tab at the bottom of the screen.
- Features you want the printout to include.
  This example shows recommended selections

- “Create Report” to see a preview.
- Printer icon to print a review copy.
- “Close” to return to previous screen.

---

**Event 1** Boys 12 & Under 100 SC Meter IM

**STROKE ORDER**
Fly, Back, Breast, Free

**Length Each Stroke**
1 Length Each Stroke

**MCSSL:** 1:06.45  8/24/1998  Jason Blomken
1:20.00  ALL*

<table>
<thead>
<tr>
<th>Lane</th>
<th>Name</th>
<th>Age</th>
<th>Team</th>
<th>Seed Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Moniz, Devan</td>
<td>12 D</td>
<td>1:20.60</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Bueller, James</td>
<td>7 O</td>
<td>1:54.63</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Book, Patrick</td>
<td>8 D</td>
<td>1:21.51</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Shade, Limp</td>
<td>11 O</td>
<td>1:15.60 ALL*</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Dough, Jon</td>
<td>6 D</td>
<td>1:21.56</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Erickson, Leah</td>
<td>12 O</td>
<td>NT</td>
<td></td>
</tr>
</tbody>
</table>

---

**Event 2** Girls 12 & Under 100 SC Meter IM

**STROKE ORDER**
Fly, Back, Breast, Free

**Length Each Stroke**
1 Length Each Stroke

**MCSSL:** 1:09.84  6/14/2008  Caroline Clark
1:21.00  ALL*

<table>
<thead>
<tr>
<th>Lane</th>
<th>Name</th>
<th>Age</th>
<th>Team</th>
<th>Seed Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fred, Lily</td>
<td>6 D</td>
<td>1:42.89</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Kane, Carrie</td>
<td>9 O</td>
<td>1:57.29</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Shatt, Pio</td>
<td>11 D</td>
<td>1:22.59</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Sauce, Pesto</td>
<td>11 O</td>
<td>1:17.03 ALL*</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Fred, Oye</td>
<td>8 D</td>
<td>1:36.56</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Jachiel,,onough</td>
<td>12 O</td>
<td>NT</td>
<td></td>
</tr>
</tbody>
</table>

---

**Event 3** Boys 200 SC Meter Medley Relay

**ALL AGES ELIGIBLE**

**Event 4** Girls 200 SC Meter Medley Relay

**ALL AGES ELIGIBLE**

**Event 5** Boys 8 & Under 25 SC Meter Freestyle

**ALL AGES ELIGIBLE**
# 4-5. Print Lane/Timer Sheets

- Reports from the Run screen, the Seeding screen, or the Main Menu.
- Lane/Timer Sheets.
- Checkbox next to events or which you want to print lane/timer sheets or Select All to print lane/timer sheets for all the events on the list.
- Checkboxes for the features you want the printout to include, such as 2 events per page, sorted by lane or event. You can print lane/timer sheets for girls and boys on different colored paper by checking “Gender.”
- Create Report to see a preview.
- Printer icon to print or close to return to the lane/timer sheet screen and make corrections.
- Close to return to previous screen.

<table>
<thead>
<tr>
<th>Lane / Timer Sheets</th>
<th>Select All</th>
<th>Go-Select</th>
<th>Preferences</th>
<th>Memoize</th>
<th>View</th>
<th>Create Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Gender</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All</td>
<td>Male</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Age Range</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Teams</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Rounds</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All Rounds</td>
<td>Finals Only</td>
<td>Index Only</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pedestal Only</td>
<td>Pedestal Only</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pedestal Only</td>
<td>Pedestal Only</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pedestal Only</td>
<td>Pedestal Only</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SESSION LIST</th>
<th>Day</th>
<th>Start Time</th>
<th>Session #</th>
<th>Course</th>
<th>Session Title</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Event List</strong></td>
<td>Event Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Event #</strong></td>
<td>Event Name</td>
<td>Event Name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Boys 12 &amp; Under 100 SC Meter IM</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Girls 12 &amp; Under 100 SC Meter IM</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Boys Open 200 SC Meter Backstroke</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Girls Open 200 SC Meter Backstroke</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Boys 8 &amp; Under 25 SC Meter Freestyle</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Girls 8 &amp; Under 25 SC Meter Freestyle</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Boys 50-50 SC Meter Freestyle</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Girls 50-50 SC Meter Freestyle</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Boys 13-14 50 SC Meter Freestyle</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Girls 13-14 50 SC Meter Freestyle</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Boys 11-12 50 SC Meter Freestyle</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Girls 11-12 50 SC Meter Freestyle</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Boys 15-16 100 SC Meter Freestyle</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Girls 15-16 100 SC Meter Freestyle</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Boys 13-14 100 SC Meter IM</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Girls 13-14 100 SC Meter IM</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Boys 8 &amp; Under 25 SC Meter Backstroke</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Girls 8 &amp; Under 25 SC Meter Backstroke</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Boys 50-50 SC Meter Backstroke</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Girls 50-50 SC Meter Backstroke</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Boys 13-14 100 SC Meter Backstroke</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Girls 13-14 100 SC Meter Backstroke</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Boys 11-12 50 SC Meter Backstroke</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Girls 11-12 50 SC Meter Backstroke</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you format “2 events or lanes per page” and sort by “lane first, then event” as shown above, you will have 25 pieces of paper for each lane. After you cut them in half, you’ll have, for each lane, odd (boys) events in one pile and even (girls) events in the other that can easily be integrated by lane.

You can print boys’ and girls’ events on different colored paper by selecting “Gender” in the top left.

Phil Dennis from Quince Orchard offers some good printing advice for teams with “top feed” printers that accept pre-cut half-sheets of paper (Canon makes a printer which supports this feature). If you have such a printer, load the half sheets into the printer. Set the Format to “1 Event Per Page Per Lane.” Set Sort By to “Lane then Event.” Set your printer preferences to print the last page first so that Event 1, Lane 1 ends up on the top of the stack, and Event 50, Lane 6 on the bottom. Using this format in “draft” mode, an entire dual meet can be ready to go in 5 minutes—No merging, no sorting or anything.
## 4-6. Pack Your Bags

<table>
<thead>
<tr>
<th>Computer and Accessories</th>
<th>Printer</th>
<th>Supplies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>Printer(s)</td>
<td>Staplers (nice to have 2)</td>
</tr>
<tr>
<td>Power Cord</td>
<td>Power Cord(s)</td>
<td>Scissors</td>
</tr>
<tr>
<td>Mouse</td>
<td>Cable(s)</td>
<td>Scotch Tape</td>
</tr>
<tr>
<td>Keyboard or Number Keypad</td>
<td>Printer Paper</td>
<td>Pens &amp; Pencils</td>
</tr>
<tr>
<td>Power Strip</td>
<td>Labels</td>
<td>Box, Container, or Envelope for printed results</td>
</tr>
<tr>
<td>USB Hub or other adapter(s)</td>
<td>Extra Printer Cartridges</td>
<td></td>
</tr>
<tr>
<td>Heavy Duty Extension Cord</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CD or flash drive with Roster &amp; Meet Entry files</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extra CDs or flash drives</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 5. **RUNNING A HOME MEET**

5-1. After the Scratch Meeting

This section shows you how to make changes from the Run screen. Do not reseed any event.

5-1a. Scratch Swimmer

In this example, Peanut Butter will be scratched from Lane 1 in Event 7.

- Run from the Main Menu.
- Highlight Event to which you want to make changes.
- Click "Adjust" to reach "Preview/Adjust." Screen.
- Click on the name of athlete to be scratched. The pop-up will ask you to confirm that you want to scratch the highlighted swimmer.
- Click Yes or No.
- "Save" to return to the Run Screen.

If you need to add a heat,
- "Add Heat at the top left of the screen.

5-1b. Add Swimmer

In this example, Monmouth Junction will be added to Lane 2, Event 20.

- Run from the Main Menu.
- Highlight Event to which you want to make changes.
- Adjust to reach "Preview/Adjust" screen.
- If you are adding a "Swim-Up,"
  - Show Swim-Ups box on the left hand column.
- Put Cursor in lane where you want to add a swimmer.
- Click to reach "Athlete List" pop-up. Scroll down the list until Monmouth Junction’s name is highlighted.
- Click OK.

Monmouth Junction is now in Lane 2.
- Save to return to the Run Screen.
5-1c. Move Swimmer

We recommend that you move swimmers by scratching them first, then adding them to their new heat or lane. Although you can move swimmers within an event by dragging and dropping, it’s difficult to keep track because when you move a swimmer to a lane occupied by another swimmer, the swimmers switch lanes.

5-1d. Add a Relay Team

- “Run” from the Main Menu.
- Highlight Event to which you want to make a change.
- “Adjust” to reach the “Preview/Adjust” screen.
- “Show Teams” to see the list of teams in the meet.
- Highlight team you want to enter in the event.
- Drag to correct lane.
- “Save” to return to the Run screen.

5-1e. Delete a Relay Team

- “Run” from the Main Menu.
- Highlight Event to which you want to make a change.
- “Adjust” to reach the “Preview/Adjust” screen.
- “Show Teams” to see the list of teams in the meet.
- Highlight team you want to delete from the event.
- A pop-up will ask you to confirm
- “Save” to return to the Run screen.
5-2. Enter Times

Run from the Main Menu. Highlight the event on which you want to work.

In the “Finals Time” column,
Type each swimmer's time without colons or periods even if swimmer is disqualified like Minnie Mouse in Lane 1.
Type NS for ‘No Shows.” In this example, Starogard in Lane 3 overslept.
Record disqualifications (DQ) by clicking the DQ checkbox.

Optional Assign DQ Code

Before you use this feature, check with the Referee and Reps. These codes are not substitutes for DQ cards which contain full explanations of violations.

Click the DQ Code pull-down menu. Check the most appropriate code based on the DQ card.

In this example, Minnie in Lane 1 swam breaststroke on the initial leg of her IM. The code for this violation, “5P Strokes out of sequence-IM,” is highlighted in the DQ Code pull-down and inserted into the DQ Code column beside Minnie’s name.

Exhibition (Non Scoring) Swims

To declare a swim as exhibition, check the “Exh” box.
In addition to the mouse, you can use up and down arrows to move among swimmers.

This graphic shows you how to move among heats and events.

You can also move from one event to another by highlighting the event, on which you want to work, in the “Event List” towards the top-left of the Run screen.

5-3. Score Event, Print Results

“Score” in the center of the Run screen

to see a preview of the Results. The “Report Preferences” set earlier ensured that each swimmer’s individual points and the team scores appeared on the report shown below.

If you see a mistake,

- to close the “Results” preview and return to the Run screen.
- Fix the problem.
- Score to return to the “Results” preview.
- Printer icon at the top of the “Results” preview to print.
- to close and return to the Run screen.
5-4. Print Award Labels

5-4a. From the Run Screen’s Awards Box

Select “Awards” box in the middle of the Run Screen to see a preview. You can print labels for only a single event from the Awards box in the Run screen.

- If you see a mistake, 
  - in either top right or top left corner to close the “Award Labels” preview and return to the Run screen.
  - Fix the problem.
  - Score to return to the “Award Labels” preview.
  - Printer icon at the top of the “Award Labels” preview to print.
  - to close and return to the Run screen.

5-4b. Batch Printing From Run Screen or Main Menu

- Labels at the top of the Run screen or from Labels on the Main Menu. If you have not set up labels, refer to 4-1c on page 20.
- Check Events you want to print. They turn yellow.
- Create Labels at the top of the screen to see a preview. If you see a mistake, “close,” fix the problem, and return to the print screen.
- Printer icon to print.
- Close to return to previous screen.

In the example, Events 1 and 2 are checked as already printed, and Events 3 and 4 are highlighted to be printed.

Tip Using a sheet of 30 labels, you could batch print according to this schedule.

Events 1-2 Events 25-29
Events 3-4 Events 30-34
Events 5-9 Events 25-39
Events 10-14 Events 40-44
Events 15-19 Events 45-48
Events 20-24 Events 49-50
5-5. Relays

“Rel Names: Ctrl-R” from the Run screen to reach the “Relay Names Screen.”

<table>
<thead>
<tr>
<th>Event</th>
<th>Age</th>
<th>Team</th>
<th>Relay</th>
<th>Lane</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7</td>
<td>MT</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>15</td>
<td>MT</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>

5-5a. Enter a Relay Swimmer

Highlight relay team for which you want to enter or delete swimmers.

- **on swimmer’s name in the “Eligible Athletes” list. The name will appear in the “Relay Order” box,**

OR

- **Drag swimmer’s name from the “Eligible Athletes” list to the “Relay Order” box.**

5-5b. Delete a Relay Swimmer

- **on swimmer’s name on the “Relay Order” box.**

5-5c. Rearrange Relay Swimmer Order

Drag & Drop names within the “Relay Order” box until the order is correct.

- **Close to return to the Run screen.**
5-6. Wrap-Up

5-6a. Back-up Database

Insert CD or flash drive.

- File→Backup from the Main Menu to reach the “Backup Current Database” screen.

Browse to drive where you want to save the backup file.

- OK.

- OK at the “Backup Options” screen.

**NOTE** New backups to the same disks do not overwrite previous backup files. If you backup more than once and you need to restore, you must be sure that you are restoring the most recent version.

Messages will flash across the screen as the back-up is created.

- OK to return to Main Menu when the back-up utility screen indicates that the back-up is complete.

*TIP* Visiting Teams should ask Home Team computer operator for a meet back-up file in addition to the Export File for Team Manager. Restore it on your team computer so that you have a copy of the meet AND can make your own Export Results File should any problems arise with the one you receive at the meet.

**ADDITIONAL TIP** Create folders and save your meet backup and meet result files in them. This is especially important for Team Unify users as will be shown in the next section.
5-6b. Export Results

5-6.b1 Upload to MCSL for All Teams

Each team, whether using Team Manager or Team Unify, must create an Export Results File and upload it to the MCSL website or e-mail it to your Division Liaison.

You can put the Export File on the same media (CD or flash drive) as you used to backup the database.

OR, you can save it to a folder on your desktop or hard drive. We recommend creating a separate folder. Just make sure you put a copy of it on a flash drive for the visiting team.

To create the Export File,

- File→Export.
- "Results for Team Manager …" (first choice) to reach the “Export Records” screen.

In the “Export Results screen,
Uncheck “Include Splits” and “Swim-off Events.”
- OK to reach the “Export File Progress” screen.

The “Export File Progress” screen will display the progress of creating the export.
- OK when the numbers stop flashing and you see “Export Finished”. and Meet Manager will ask you where you want to copy the results.

Browse to a CD or flash drive when you see the “Meet Results” screen to save your file.
- OK when Meet Manager tells you that the file has been zipped successfully and confirmed the location of your file.

5-6.b2 Additional Upload for Team Unify Users

Before uploading meet results, each Team Unify user must edit the Export Results File.

The link below will take you to a video, prepared by the Team Unify staff, that demonstrates how to edit the file.

http://bcove.me/qt8nb5k0
5-6c. **Print Complete Meet Results**

- Reports from the Main Menu.
- Select Results to reach the “Results” Screen.
- Select All. The events will be highlighted in yellow.
- Tabs at bottom of screen to format the report.

Setting the columns to “Triple” requires less paper and usually prints a little faster. Double Column is a little easier on failing eyesight.

5-6d. **E-Mail Results to Division Automation Liaison**

E-mail the Export File and the Meet Back-Up file to your Division Liaison by 2:00 pm. **IN**CLUDE** SCORE IN THE E-MAIL MESSAGE AND A PHONE NUMBER WHERE YOU CAN BE REACHED.

5-6e. **Post to your Website**

To make an HTML File, follow the above directions for printing. In the “Columns/Format” tab, select “Flat HTML.” Meet Manager defaults to c:\hy-sport\win-mm\html, but you can browse to another location.

5-6f. **Update Records**

- Events from the Main Menu.
- Records
- Update
- OK if the highlighted items are correct.
# Get Ready for Next Week

## Import Meet Results into Team Manager

<table>
<thead>
<tr>
<th>Insert</th>
<th>CD or flash drive containing the Export Results file, OR browse to a folder on your desktop or hard drive.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>File from the Main Menu.</td>
</tr>
</tbody>
</table>

- **File from the Main Menu.**

- **Import → Meet Results**

- **Browse** to CD or flash drive containing your file when you the “Import Results” screen.

- **After selecting the file to import, Team Manager will tell that the file you just selected has been unzipped.**

- **OK to reach the screen containing the unzipped file.**

- **Highlight the unzipped file.**

- **It now has an *.hy3 extension.**

- **OK to start the import.**

- **Team Manager will display the progress of the import in the “Import Statistics” box.**

- **When the import finishes, the bottom left-corner will read “Import Successful.”**

- **Close to return to the Main Menu.**

If you unintentionally import another team’s results. Click “Teams” from Team Manager’s Main Menu, highlight the team you imported by mistake, click “Delete.”
5-6.g2 Restore Meet Manager

Insert CD or flash drive that contains the meet database created in Section 5-6a.

- File
- Restore to reach the “Restore Method” screen.
- Replace, etc. (the first choice)
- OK.

Highlight The file you want to restore. Follow instructions confirming that you want to restore. You will return eventually to the Main Menu.

Highlight The file containing the meet database.

- OK to confirm that you want to restore when you see “Unzip and Replace the Currently Open Database.”

- Yes to confirm again.

- OK to return to Main Menu.

NOTE Subsequent backups do not overwrite previous backups. The file name changes with each backup by adding 01, 02, 03 to the end of the file name as shown above.
5-6h. Submit an MCSL Record

When a swimmer or a relay team sets a new MSCL record at a dual meet, Relay Carnival, or Divisionals, the host team is responsible for notifying the Records Chairperson. The next two sections depict the information that should be included on the lane/time sheet that documents the record breaker’s times.

5-6.h1 Lane/Timer Sheet for Submitting a Record in an Individual Event

<table>
<thead>
<tr>
<th>Event 31 Men 9-10 25 SC Meter Breaststroke Finals</th>
<th>Official Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lane 1 Heat 1 Little, Chicken 10 Omega 22.30</td>
<td>22.26 22.23 22.24 22.24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Timer</th>
<th>Team</th>
<th>Print Name</th>
<th>Signature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer 1</td>
<td>D</td>
<td>Minnie Mouse</td>
<td>Minnie Mouse</td>
</tr>
<tr>
<td>Timer 2</td>
<td>O</td>
<td>Donald Duck</td>
<td>Donald Duck</td>
</tr>
<tr>
<td>Timer 3</td>
<td>D</td>
<td>Red Rover</td>
<td>Red Rover</td>
</tr>
<tr>
<td>Head Timer</td>
<td>D</td>
<td>Pesto Sauce</td>
<td>Pesto Sauce</td>
</tr>
<tr>
<td>Referee</td>
<td>D</td>
<td>Milk Shake</td>
<td>Milk Shake</td>
</tr>
</tbody>
</table>

Host Team Rep Name; Phone or e-mail: Brunhilda Zwoomwick 123-456-7890

5-6.h2 Lane/Timer Sheet for Submitting a Record in a Relay Event

<table>
<thead>
<tr>
<th>Event 49 Boys 14 7 Under 175 SC Meter Freestyle Relay Finals</th>
<th>Official Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lane 1 Heat 1 Omega 1:45.25</td>
<td>1:45.01 1:45.07 1:45.02 1:45.02</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Swimmer 1</th>
<th>Swimmer 2</th>
<th>Swimmer 3</th>
<th>Swimmer 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Little</td>
<td>Donald</td>
<td>John</td>
<td>Road</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Timer</th>
<th>Team</th>
<th>Print Name</th>
<th>Signature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer 1</td>
<td>D</td>
<td>Minnie Mouse</td>
<td>Minnie Mouse</td>
</tr>
<tr>
<td>Timer 2</td>
<td>O</td>
<td>Donald Duck</td>
<td>Donald Duck</td>
</tr>
<tr>
<td>Timer 3</td>
<td>D</td>
<td>Red Rover</td>
<td>Red Rover</td>
</tr>
<tr>
<td>Head Timer</td>
<td>D</td>
<td>Pesto Sauce</td>
<td>Pesto Sauce</td>
</tr>
<tr>
<td>Referee</td>
<td>D</td>
<td>Milk Shake</td>
<td>Milk Shake</td>
</tr>
</tbody>
</table>

Host Team Rep Name; Phone or e-mail:______________

5-6.h3 3 Ways to Submit a Record

1. Snail mail (via the post office)
   Make a copy for your records.
   Linda Raab, MCSL Records Chair
   6606 Old Stage Road, Rockville, MD 20852-4328
   301-984-8812
2. Fax
   240-465-0741
3. Scan and e-mail as a pdf
   records@mcsl.org
Chapter 6.  TIME TRIALS USING TEAM MANAGER

This chapter describes setting up and recording time trial results in Team Manager. To begin, download the Meet Event Files from the MCSL website and import each file into Team Manager.

6-1. Create Time Trial Meet

- “Meets” from the Main Menu to reach the Meet Browser.
- “Add” to reach the “Meet Maintenance” set-up box.

Fill in
- Meet Name
- Course
- Meet Type, see Section 1-5 for help

The “Age Up Date” should already be set to June 1 of current year.

- OK, then “Cancel” to return to the Meet Browser.

As shown here, the list of meets in the “Meet Browser” includes the newly-created Time Trials.

<table>
<thead>
<tr>
<th>Meet Name</th>
<th>Course</th>
<th>Meet Type</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>2009 Omega Team Time Trials</td>
<td></td>
<td></td>
<td>Jun 07, 2009</td>
</tr>
<tr>
<td>20-Jun-09WEEK 1A 2009</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6-2. Copy Events

Highlight the time trial meet you just created.

- Events to reach the “Events” menu for the time trial meet. The screen will be gray.
- “Copy Events.” Select one of the “A” meets installed in Section 1-4.

When Meet Manager finishes copying the events, the “Copy Options” box in the bottom-left changes to show the number of events copied.

- “Close” to return to the “Events” browser.
The events will be listed as shown below.

6-3. Entering, Editing, and Deleting Times

Highlight the time trial meet for which you copied events.

6-3a. Entering Times

“Results.” Follow steps below.
6-3c. Deleting Times

If you try to delete an entire result from either the "Results by Event" or "Results by Name" browser, Meet Manager will display a box that reads "Please use the Results Browser to Delete a Meet Result."

OK in the message box. Then close the screen in which you are working to return to "Meet Browser."

Highlight the swimmer whose result is to be deleted, in this example, Tomato Sauce.

"Delete." Team Manager will ask you to confirm deletion. You can continue working in this screen, or close it to return to the "Meet Browser."
6-4. Print Results

- "Reports" from the Main Menu, then "Results Reports."

- Highlight the meet to be printed.

- Click Reports—Print

- Click here to see preview.

- Individual Meet Results Report

- Click here to print report.
Chapter 7. AUTOMATING “B” MEETS

MCSL does not set rules for “B” meets. In response to comments about “B” meets over the years, the Executive Board offers this guidance to help teams design the automation component of their “B” programs.

7-1. Team Manager Preparation

If meet not seeded ahead of time (like an “A” meet), you do not need event files, and you can skip this entire section.

7-1a. Download and Import “B” Meet Events Files

☐ Download “2011MeetEventsFilesforTeamManager.zip” from MCSL website and unzip the files to a folder on your hard drive. See Section 1-4a, page 9.

☐ Import event files into Team Manager. See Section 1-4b, page 9. Do this BEFORE changing meet dates.

7-1b. Designate Meet Types in Team Manager

See Section 1-5, page 10, recommend code is “B,” and description is “B Meet.”

7-1c. Change Meet Dates

The templates are set up to hold “B” meets on 5 consecutive Wednesdays on the following dates.

June 22  June 29  July 6  July 13  July 20.

Meet from Main Menu.
Select Meet Name.
Change Start and End Date
Make sure Age-up Date is 6/1/2011.

WARNING

It’s OK to hold “B” meets on dates other than those listed above, you must change the meet start and end dates in Team Manager as shown here and in Meet Manager. The meet dates must be the same in both Team and Meet Manager in order for the entries to be properly exported from Team Manager and imported into Meet Manager.

It’s also OK to change the meet name as long as you change it to the exact same name in Meet Manager and Team Manager.
7-2. Meet Manager Preparation

7-2a. Download “B” Meet Templates
See Section 0, page 11.

7-2b. Change Meet Dates in Meet Manager

- Set-up.
- Select Meet Set-up.
- Change Start and End Date
  Location—Optional
  MAKE SURE AGE-UP DATE IS 6/1/2011.
- OK.

7-2c. Choose Scoring Option

7-2.c1 Not-Scored Meet
If you do not want to score your “B” meet,
- Set-up
- Select Options Global Changes
  “Set every event with the NOT to score setting.”
- OK.

7-2.c2 Scored Meet
Do nothing. Scoring is already part of the meet set-up.
7-2.c3 Multi-Age Scoring

If each age group is to receive its own set of awards, consider multi-age scoring rather than adding events.

- Events from the Main Menu. Highlight the event on which you want to work.
- Edit OR on the event to reach the “Event Edit” screen.
- “Multi-Age Group” box on left in the “Event Edit” screen.
- the square on the right to reach, the “Multiple Age Groups” box.
- Edit the age groups.
- OK twice to return to the “Events” screen.

Repeat for each event where you want multi-age scoring.

In the example below, Event 5, Boys 8&U Free, is edited so that the 6&U, 7 year olds, and 8 year olds are ranked separately. This allows 8&U to swim together in Event 5, but each age group will get its own set of awards. Designate “6 & U” by leaving the low age blank. Multi-age scoring can rank swimmers in any age groupings regardless of whether the “B” meet is scored.

In the example below, Event 5, Boys 8&U Free, is edited so that the 6&U, 7 year olds, and 8 year olds are ranked separately. This allows 8&U to swim together in Event 5, but each age group will get its own set of awards. Designate “6 & U” by leaving the low age blank. Multi-age scoring can rank swimmers in any age groupings regardless of whether the “B” meet is scored.

Make sure that the “Multi-Age Group” box is checked.

The results would look like this. The 6, 7, and 8 year olds were seeded in Event 6, 8 & Under 25 Free without regard to age. The Multiple-Age Group feature ranks them separately within Event 6.

<table>
<thead>
<tr>
<th>Event 5</th>
<th>Women 8 &amp; Under 25 SC Meter Freestyle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Seed Time</td>
</tr>
<tr>
<td>6 &amp; Under Results Timed Finals</td>
<td>6 Delta Team-PV</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>1 Konor, Mary</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>2 Park, Ashley</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>3 Feen, Lita</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>4 Home, Claire</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>5 Jesse, Makayla</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>6 Brook, Clayton</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>7 Fedd, Tish</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>8 Coat, Teri</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>9 Baill, Keri</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>10 Paul, Book</td>
</tr>
<tr>
<td>6 Year Olds Results Timed Finals</td>
<td>11 Kowda, Anjali</td>
</tr>
</tbody>
</table>
Award labels will look like this. First-place ribbons will be printed for: Tuna Fish, 1st place 6-year old; Mary Kontrary, 1st place 7-year old; and Nalcika Jerevan, 1st place 8-year old.

7-2d. Format Award Labels
See Section 4-1c, page 20.

7-2e. Import Team Rosters
- Obtain “Athlete Roster” Files from visiting team. Unless your “B” League has rules to the contrary, it’s OK to obtain them by e-mail.
- Make Roster File for your team. See Section 3-3, page 16.
- Import each roster file into the meet. See Section 4-2a, page 22.

7-2f. Seed Meet
7-2.f1 Seeded Ahead of Time
- Import entry files for the home and visiting teams as for an “A” meet. See Section 4-2b, page 23.
- Designate odd and even lanes as shown below.

! Set-up.
Select Seeding Preferences
Drag Team Name to proper lanes.
! OK to return to the Main Menu.

Recommend NOT checking “Strict Assignment All Heats” so that events with many more swimmers on one team will be placed in adjacent lanes.

- Seed the meet like an “A” meet. See Section 4-3b, page 27.

7-2.f2 Deck-Seeded
Do nothing. Swimmers will be assigned lanes and times recorded while the meet is running.

7-3. Run the Meet
7-3a. Enter Times
7-3.a1 Deck-Seeded Meet
In this example, the meet is not seeded ahead of time as it is for the “A” meets.

! Run from the Main Menu. The bottom of the run screen will look like the one below. No swimmers are entered. You will first enter the swimmers, then type their times.

! “Adjust” to begin entering swimmers into events. Do not worry about lanes or entry times. It’s more important to match each swimmer with his/her correct time. See Section 5-1b, page 31.
7-3.a2 Seeded Meet (like an “A” Meet)
See Section 5-2, page 33.

7-3b. Score Event, Print Results
See Section 5-3, page 34.

7-3c. Print Award Labels
See Section 5-4a, page 35.

7-3d. Wrap-up
7-3.d1 Back-up and Export
  - Make meet back-up file. See Section 5-6a, page 37.
  - Create meet export files. See Section 5-6b, page 38.
  - Keep a copy of each file for yourself and put a copy of each file on a flash drive for the guest team or e-mail them as soon as possible after the meet.

7-3e. Import Results to Team Manager
  - Import the results back to Team Manager. See Section 5-6.g1, page 40.
  - Make sure that the “B” meet is designated as such in Team Manager so that you won’t mistakenly enter swimmers into Divisionals with other than “A” meet times. See Section 1-5, page 10.

7-3f. Print a DQ List
  This is optional. See Section 9-2c, page 64.

7-4. Automation Tips for Deck-Seeded “B” Meets
Jim Berry from Somerset has put together the following ideas for automating “B” meets.

7-4a. Preparation
1. Increase the number of lanes to the maximum (10) for all events. Why? When locating swimmers from the roster and entering times, much time and energy is spent adding new heats and moving to other heats. By having 10 instead of 6 per heat, there will be fewer heats and less wasted time.
   To do this, go to the Main Menu.

Click “Setup,” “Options.”
Click “Change number of lanes for all Final Rounds to,”
Enter “10” in the little box at the end of the sentence.
Click OK to save.
Then click “Seeding Preferences.” Select the “Standard Lanes” tab. Click the little red button.

In the Standard Lane Preferences, highlight “10 lanes” if not already highlighted. Click OK to save.

2. If all swimmers are to receive a ribbon, select “Participation” as the type of ribbon to ensure that every swimmer—even those disqualified—gets a ribbon.

3. Ask if any swimmers are not yet on computer roster. Get correct spelling, sex, DOB; add them before meet starts.

7-4b. Running the Meet

Jim describes an operation that uses 4 people—SORTER, READER, OPERATOR, VERIFIERS.

Sorter
1. Accepts entry cards from runner.
2. Staples DQ cards to correct cards. Be alert for slow DQ cards.
3. Checks that right time is circled.
4. Sorts cards alphabetically by last name. Optional but recommended.
5. Hands the cards to the READER.

Reader
1. READER first calls out names of swimmers to the computer OPERATOR. If following above advice, these will be in alphabetical order.
2. READER now calls out the names and times for each swimmer, hopefully in the same order as in previous step.
3. READER and OPERATOR should do a quick sanity check, but recommend that other volunteers verify results.

Operator
1. Working with the READER, locates names and enters them in the Adjust screen.
2. Working with the READER, enters times.
3. Print 1 copy of results. Entry cards and Result sheet handed to VERIFIERS.
4. OPERATOR prints awards labels when appropriate after VERIFIERS are finished.

Verifiers

VERIFIERS check printed results against the times written on the entry cards.

Two people as a team work well, provided that they move away from the scorers’ table.

Idea: Since the printed results will list the swimmers by the times they swum, some verifiers might find easier to compare the cards with the printed results by organizing the cards according to the results (swum time). Hy-tek offers no option to print results alphabetically.

1. No need to hand print participation labels for disqualified swimmers as long as Step 2 in 7-3b is followed.
2. Separate time cards by team and place in each team’s box.
Chapter 8. RELAY CARNIVAL

8-1. Team Responsibilities

8-1a. Team Rosters

Each team in a division must submit a roster file (See Section 3-3, page 16) and a paper copy of the roster (See Section 3-2.a1, page 15) just as you would for an “A” meet.

As for “A” meets, create a new roster file and hard copy for the relay carnival organization meeting which may take place up to a week prior to the meet. If new swimmers join the team after you created the roster, your Rep needs to provide the new swimmer(s)’ name(s) to the host team. Accordingly, he/she may ask you to create a new roster file. As with “A” meets, we strongly recommend that you print a paper copy of each roster file that is submitted to other teams. Since the date is included in the top right corner of each hard copy, there should be no confusion over the current roster.

8-1b. Relay Swimmer Names

Each team must also supply the names of the relay swimmers. You may be asked to bring this list to the meet. Do not import entries with relay names from Team Manager due to the special lane rotation, swimmer names must be added manually.

8-2. Host Responsibilities

8-2a. Rosters and Relay Swimmer Names

Prepare team rosters and relay swimmer names as described in Section 8-1.

8-2b. Check Division Rank

Check the pre-season ranking of the teams in your division.

In this example, the teams in Division X are ranked as follows.

1. GR Griffindor
2. HP Hufflepuff
3. RC Ravenclaw
4. SL Slytherin
5. DS Durmstrang
6. BB Beaubatons

8-2c. Edit Teams

Open Meet Manager.


DO NOT CHANGE ANY SETTINGS IN EXCEPT AS SHOWN BELOW.

DO NOT CHANGE THE DATE RANGE IN THE MEET SET-UP MENU.

Teams. Highlight Team 1.

Edit, OR to reach the “Team Edit” menu.

Change Team Abbr, Full and Short Team Names to those of the team ranked first in your division.

OK.

Repeat For each team.

Close Teams Menu.

Leave the “Alt Team Abbr” to maintain a record of the division rankings.
8-2d. Verify

Run.
Highlight Event 1.
The lane assignments should correspond with each team’s pre-season ranking.

OR
Print a Meet Program.

8-2e. Print Meet Program
See Section 4-4, page 28. You need not click “Entry Times” since lanes are not assigned according to times or dual meet rules. Be sure you check “Event Comments” in the “Include in Meet” tab. The comments provide information on the proper composition of each relay as shown in the example below. A complete list can be found at the end of this Chapter.

8-2f. Format and Print Lane/Timer Sheets
See Section 4-5, page 29.

8-2g. Set Label Preferences

8-2h. Run Screen
“Preferences” from the Run Screen
Select “Award Labels” to reach the “Award Preferences in Run…”

Relay Names should be set to 5.
8-2i. Report Screen
- Awards from the Main Menu
Select Award Labels to reach the “Award Labels” screen.

Set Relay names to 5.

8-2j. Change Report Headers (Optional)
You might want to change the report header to display the division name, date, team names, etc.

8-2k. Import Team Rosters
Import each team’s roster as in Section 4-2a, page 22.

DO NOT IMPORT ENTRIES WITH RELAY NAMES FROM TEAM MANAGER. Due to the special lane rotation, swimmer names must be added manually.

It’s OK to add swimmer relay names at any time prior to the start of the meet. These entries are not binding until the relay cards are presented to the Clerk of Course.

8-3. Automation Recommendations
We also recommend that each team’s automation person share automation duties with the host automation person so that everyone can enjoy the meet and watch their children swim. Accordingly, each team should provide one automation person to work the meet.

We recommend that each team’s automation person enter his/her team’s relay names during his/her team’s warm-up. Even though the make-up of each relay is not final until the relay card is submitted to the clerk of course, having relay names entered when the meet begins takes a lot of pressure off a single computer operator who otherwise must enter each relay name at the conclusion of each race. Needless to say, swimmer names on each relay card must be compared to the names entered prior to the meet start.
Composition of Relays for Relay Carnival

<table>
<thead>
<tr>
<th>Relay Type</th>
<th>Relay Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Boys 14 &amp; Under 175 Freestyle Graduated Relay</strong></td>
<td>RELAY ORDER 9-10, 2 Lengths; 11-12, 2 lengths 13-14, 2 Lengths; 8 &amp; Und, 1 length</td>
</tr>
<tr>
<td><strong>Girls 14 &amp; Under 175 Freestyle Graduated Relay</strong></td>
<td>RELAY ORDER 9-10, 2 Lengths; 11-12, 2 Lengths 13-14, 2 Lengths; 8 &amp; Und, 1 Length</td>
</tr>
<tr>
<td><strong>Mixed 15-18 200 Freestyle Relay</strong></td>
<td>MUST INCLUDE 2 BOYS AND 2 GIRLS 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Mixed 13-14 200 Freestyle Relay</strong></td>
<td>MUST INCLUDE 2 BOYS AND 2 GIRLS 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Mixed 8 &amp; Under 100 Freestyle Relay</strong></td>
<td>MUST INCLUDE 2 BOYS AND 2 GIRLS 1 Length Each Swimmer</td>
</tr>
<tr>
<td><strong>Mixed 9-10 200 Freestyle Relay</strong></td>
<td>MUST INCLUDE 2 BOYS AND 2 GIRLS 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Boys Open 200 Medley Relay</strong></td>
<td>ALL AGES ELIGIBLE Back, Breast, Fly, Free 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Girls Open 200 Medley Relay</strong></td>
<td>ALL AGES ELIGIBLE Back, Breast, Fly, Free 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Boys 14 &amp; Under 100 Medley Graduated Relay</strong></td>
<td>1 SWIMMER EACH 8&amp;U,9-10,11-12,13-14 Back, Breast, Fly, Free 1 Length Each Swimmer</td>
</tr>
<tr>
<td><strong>Girls 14 &amp; Under 100 Medley Graduated Relay</strong></td>
<td>1 SWIMMER EACH 8&amp;U,9-10,11-12,13-14 Back, Breast, Fly, Free 1 Length Each Swimmer</td>
</tr>
<tr>
<td><strong>Boys 8 &amp; Under 100 Medley Relay</strong></td>
<td>STROKE ORDER Back, Breast, Fly, Free 1 Length Each Swimmer</td>
</tr>
<tr>
<td><strong>Girls 8 &amp; Under 100 Medley Relay</strong></td>
<td>STROKE ORDER Back, Breast, Fly, Free 1 Length Each Swimmer</td>
</tr>
<tr>
<td><strong>Boys 9-10 100 Medley Relay</strong></td>
<td>STROKE ORDER Back, Breast, Fly, Free 1 Length Each Swimmer</td>
</tr>
<tr>
<td><strong>Girls 9-10 100 Medley Relay</strong></td>
<td>STROKE ORDER Back, Breast, Fly, Free 1 Length Each Swimmer</td>
</tr>
<tr>
<td><strong>Mixed 15-18 200 Medley Relay</strong></td>
<td>MUST INCLUDE 2 BOYS AND 2 GIRLS Back, Breast, Fly, Free 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Boys 11-12 200 Medley Relay</strong></td>
<td>STROKE ORDER Back, Breast, Fly, Free 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Girls 11-12 200 Medley Relay</strong></td>
<td>STROKE ORDER Back, Breast, Fly, Free 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Boys 13-14 200 Medley Relay</strong></td>
<td>STROKE ORDER Back, Breast, Fly, Free 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Girls 13-14 200 Medley Relay</strong></td>
<td>STROKE ORDER Back, Breast, Fly, Free 2 Lengths Each Swimmer</td>
</tr>
<tr>
<td><strong>Boys 18 &amp; Under 250 Freestyle Crescendo Relay</strong></td>
<td>RELAY ORDER: 8 &amp; Under, 1 Length 11-12, 2 Lengths; 15-18, 4 Lengths 13-14, 2 Lengths; 9-10, 1 Length</td>
</tr>
<tr>
<td><strong>Girls 18 &amp; Under 250 Freestyle Crescendo Relay</strong></td>
<td>RELAY ORDER: 8 &amp; Under, 1 Length 11-12, 2 Lengths; 15-18, 4 Lengths 13-14, 2 Lengths; 9-10, 1 Length</td>
</tr>
</tbody>
</table>
Chapter 9. **BELLS & WHISTLES**

9-1. **Team Manager**

This section highlights some ways to customize Team Manager for your own team. These are optional and are not needed to maintain League-required information.

9-1a. **All-Star Times and Records**

To determine whether you can track all star times and records in Team Manager,

- “Help → About” from the Main Menu to reach the registration and licensing screen.

If “Standards and Records” is checked, your Team Manager program can store and track your swimmers’ all-star times and pool and team records.

- If you keep all-star times in your Team Manager database, update them by either editing via Standards + + Add/Edit from the Main Menu, or by importing the all-star nominating standards file from the MCSL web site. You can import and export these files to and from Meet Manager.

- To edit, add, import or export records, select “Records” from the Main Menu. Like All-Star files, you can import and export to and from Meet Manager.

9-1.a1 **Editing**

- Standards → Add/Edit Standards or Records → Add/Edit Records from the Main Menu to reach the appropriate screen. The rest of this section shows how to edit only Standards (All-Star) information, because the process for Records is similar.

```
<table>
<thead>
<tr>
<th>Standards</th>
<th>Records</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add/Edit Standards</td>
<td>Add/Edit Records</td>
</tr>
<tr>
<td>Import Standards</td>
<td>Import Records</td>
</tr>
<tr>
<td>Export Standards</td>
<td>Export Records</td>
</tr>
</tbody>
</table>
```

Set “Course” to “SCM.”

Make changes like a spreadsheet.

- to close the window to return to the Main Menu.
9-1.a2 Importing

- Standards ➔ Import Standards (Records).
- Browse to the location where standards file is stored.
- Highlight file
- OR
- Open to reach the “Import Standards” menu.
- OK when “Import Standards” appears.
- OK when asked if you want to continue with new name.

This screen will appear when importing is finished. The number of standards may be different from this example.

- OK to return to the Main Menu.
- Standards ➔ Add/Edit Standards to see the imported data. In the “Course” pick list, select “SCM.”

TIP No Need To Retype! Section 9-2.a4 on page 64 describes how to export records from Meet Manager. Exporting the standards file containing all-star times is similar.

Below is a “Top Times” report from a Team Manager database containing all-star and record information. Unlike Meet Manager, Team Manager does not provide event headings listing the record or time standard that has been equaled or bettered.

<table>
<thead>
<tr>
<th>Time</th>
<th>P/F/S</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloth, Table (11) B</td>
<td>F</td>
<td>100 IM</td>
</tr>
<tr>
<td>2:00.45 S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fair, Book (11) G</td>
<td>F</td>
<td>100 IM</td>
</tr>
<tr>
<td>1:56.00 S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Horner, Little Jack (8) B</td>
<td>F</td>
<td>100 IM</td>
</tr>
<tr>
<td>1:21.00 S</td>
<td>ALL*</td>
<td></td>
</tr>
<tr>
<td>Little, Chicken (10) B</td>
<td>F</td>
<td>100 IM</td>
</tr>
<tr>
<td>1:22.45 S</td>
<td>ALL*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>F</td>
<td>100 IM</td>
</tr>
<tr>
<td>1:44.50 S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pleasant, Point (12) B</td>
<td>F</td>
<td>100 IM</td>
</tr>
<tr>
<td>1:10.00 S</td>
<td>REC</td>
<td></td>
</tr>
<tr>
<td>1:45.72 S</td>
<td>F</td>
<td>100 IM</td>
</tr>
<tr>
<td>Podd, Tri (11) G</td>
<td>F</td>
<td>100 IM</td>
</tr>
<tr>
<td>1:21.33 S</td>
<td>ALL*</td>
<td></td>
</tr>
<tr>
<td>Sauce, Apple (10) G</td>
<td>F</td>
<td>100 IM</td>
</tr>
<tr>
<td>1:34.89 S</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

“*ALL” beside a swimmer’s name shows that he/she has achieved an all-star time. “REC” indicates a record-breaker.
9-1b. Customize Age Groups to Mirror MCCL Events

Since Team Manager’s default age groups are different from MCCL’s age groups, reports do not organize events as the League does. You can customize Team Manager so that your reports will reflect the League’s list of events.

1. Set-up from the Main Menu. Highlight Preferences → Report Custom Age Groups.

2. “Age Group.” The box will turn yellow.
3. “Add” to reach the “Custom Age Group” box. You can do this only for individual events.
4. Fill In Low and High ages. This example sets up the 12 & Under IM. Set “Low Age” to 0.

5. OK to reach the “Define Custom Age Groups for Reports.” The next 5 graphics show the set-ups for the other age groups.
When you finish, your list will look like the one shown opposite minus the numbers in the “Event Order” column.

The events are sorted by age group.

Fill in numbers in the “Event Order” column as shown.

To Print a Top Times Report Using MCSL-Formatted Age Groups,

- “Reports” from the Main Menu Bar.
- “Performance”.
- “Top Times.”
- All the options shown in the opposite screen.
  In the bottom right corner, decide how many times you’d like to see. To print all times, type 0. Then select the number of columns.
- “Create Report.”

9-1c. Customize Athlete Reports

Team Manager includes a feature that lets you customize athlete reports. This is an example of how to set up a report that displays athlete e-mail addresses and cell phone numbers.

- “Set-up” from the Main Menu Bar.
- “Custom” Layouts for Athlete Reports.
- “Add Layout” to create a new layout. Type name for Layout.
- OK to start laying out the report in the “Custom Athlete Report Layout.”
Drag each report item from “Report Fields” to Line 1. “Size” refers to the number of characters in the column. You can change them by typing different numbers. In this example, the size of the “Ath Cell” column was changed from 20 to 15 so that the total number of characters in the line would not exceed 95.

- Insert or delete buttons at the bottom of the box.
- “Portrait” or “Landscape at the top of the layout menu. Note that there is a limit on the total number of characters allowed, but Meet Manager sums the characters as you format columns.
- Show Line 2 and Show Line 3 radio buttons to create a multi-line layout.
- Review at the top of the menu to see how the report will look.
- Save to return to Main Menu. Meet Manager will prompt you to confirm that you want to save.

“Reports→Administrative→Athletes” from the Main Menu.
Select Custom Layout. Use the “Available Layouts” pull-down menu to select the report you want to print.
- “Create Report.”

Printer icon to print the report.

<table>
<thead>
<tr>
<th>Athlete Cell Phones and E-Mails</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Martina</td>
</tr>
<tr>
<td>Lester</td>
</tr>
<tr>
<td>Dylan</td>
</tr>
<tr>
<td>Blaine</td>
</tr>
</tbody>
</table>

9-1d. Personal Best Labels and Reports

Team Manager has a report under Labels which shows Personal Best times achieved at a particular meet. Even if your team does not issue personal best ribbons, one can print that page on paper.
- Labels from Main Menu Bar
- Improvement
- Select which meet, label size.
- Create Report
9-1e. Season Improvement Reports
Team Manager Top Times can show improvement over the entire season. Here is one of the many variations to show improvement since Time Trials:

- Reports from Main Menu Bar
- Performance
- Top Times

Select Use Since Date
- Use Time Since and enter a date before Time Trials (06/01/10)
- Chronological

Select Improvement
This will bring up the “Show Improvement” options.

Select Seasonal (Best)
Select Earliest Time after Since Date as Baseline (to use Time Trials as a base)
Select Create Report

9-2. Meet Manager
9-2a. Records
The templates on the MCSL website include MCSL records as of the beginning of the swim season. This section shows you how to enter, import, export, and use other records. Meet Manager 2.0 has a new feature that allows you to designate records that only one team may break.

9-2a.1 Creating
- Events from the Main Menu. Select “Records” at the top of the screen.
- 

Fill in as follows.

<table>
<thead>
<tr>
<th>Order</th>
<th>The order in which you want the record to appear on meet programs and results reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag Name</td>
<td>The name of the record</td>
</tr>
<tr>
<td>Flag</td>
<td>Symbol next to record breaker’s name</td>
</tr>
<tr>
<td>Record Only For</td>
<td>Designates records that only one team may break. In this example, the Omega Team is highlighted so that Meet Manager will not flag Delta Force swimmers who achieve times faster than Omega records</td>
</tr>
</tbody>
</table>

When you are finished, the box will look like this. Only Omega swimmers can break Omega records, but anyone can break MCSL records.

Type your records information like a spreadsheet.

Make sure that you set the Gender, Age Range, etc. as shown.
9-2.a2 Editing and Updating

Select Records.

To edit record-holder names, times, dates, or teams, make changes like a spreadsheet.

The following table shows how to change the name of a team record, its symbol, display order, or to restrict team record breakers to their own teams.

<table>
<thead>
<tr>
<th>Order</th>
<th>Tag Name</th>
<th>Flag</th>
<th>Team Only</th>
<th>EditOK</th>
<th>ForeignOK</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>MCSL</td>
<td>L</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>Omega Team</td>
<td>O-PV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03</td>
<td>Cellia Team</td>
<td>O-PV</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To restrict record-breakers,

Highlight team name

- Pull-down menu in the “Team Only” column.

Highlight team to which the record will be restricted.

Change the Flag symbol by typing change in the box to the right of the tag name.

To change “Order” or “Tag Name,”

Highlight name of record file you want to change.

- to reach “Edit Record Tag Name.”

Type Changes

- OK to save.

9-2.a3 Importing

Select Records.

- Import.

Browse to the file location.

Select file with the records to import.

- Open.

- OK. You cannot make any changes here in the Select New Tag box.

The records should appear on the list. If not, uncheck “Show Records-Selected Tag Only” in the bottom right corner.

Once you have imported records, you can make changes. See “Editing and Updating.”
9-2.a4 Exporting

- Events from the Main Menu.
- Select Records.
- Highlight Record to be exported in the bottom-left corner. In this example, the Omega Team Record is highlighted.
- Export in the top-left corner.
- Yes on the "Create a Records File" pop-up screen.
- Browse to the file location where you want to store the file and save it.

9-2b. Printing All-Star Swimmer List

- Reports from Main Menu.
- Exceptions Report.
- "All Events"
- "Stds/Qual tab in the middle of the menu.
  Make the selections shown in the "Stds/Qual" tab as shown.
- OK.
You can separate by team if you check "By Team" under "Sort" in the bottom left corner.
You can print a list of all-star times only for the entire meet. There is no report that will print a list for a few events at a time.

9-2c. Printing DQ List

- Reports from Main Menu.
- Meet Summary.
- "All Events"
  Make the selections shown in the "Report Type/Format/Options" tab as shown.
- OK.

9-2.c1 Printing Record Breakers

- Reports from the Main Menu
- Meet Summary
- Select Record Breakers
- Create Report